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All product names, logos, and trademarks referred to in this document shall belong to their

owners.

The trademarks «МойОфис» and MyOffice belong to New Cloud Technologies Ltd.

Nothing in these terms shall be construed under any circumstances as direct or indirect

provision of a license or right to use the trademarks, logos or service marks used herein. Any

unauthorized use of these trademarks, logos or service marks without the written permission of

their owner is strictly prohibited.
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LIST OF ABBREVIATIONS

The abbreviations used in this document are given in the Table 1.

Table 1. Abbreviations and definitions

Abbreviation Definition

OS Operating system

MyOffice Text MyOffice Text. Home Edition desktop application

MyOffice Spreadsheet MyOffice Spreadsheet. Home Edition desktop application

MyOffice Presentation MyOffice Presentation. Home Edition desktop application



5

© New Cloud Technologies Ltd., 2013–2024 5

1 GENERAL INFORMATION

1.1 About

MyOffice Standard. Home Edition is an office suite for private users to work with text

documents, spreadsheets, and presentations.

The suite includes the following applications to run on Windows and macOS operating

systems:

– MyOffice Text editor for fast and convenient creation and formatting of text documents

of any complexity.

– MyOffice Spreadsheet editor for creating spreadsheets, conducting calculations,

analyzing data, generating summary reports, and automating data processing using

macros.

– MyOffice Presentation editor for creating, designing and demonstrating presentations.

A detailed description of the features of the product can be found in the

MyOffice Standard. Home Edition. Feature List.
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1.2 System requirements

Product

(software

installer)

Hardware requirements

Software requirements
Minimal Recommended

MyOffice

Presentation

for Microsoft

Windows

(64-bit)

– Processor: 

1 GHz x86-64

– Memory: 2GB RAM

– Hard disk: 3GB of

available disk space

– Display: 1024х768

screen resolution

– Peripherals: Mouse,

keyboard

– Processor: 

2 GHz or faster x86-64

processor

– Memory: 3GB RAM or

more

– Hard disk: 5GB of

available disk space

– Display: 1920х1080

screen resolution and

above

– Peripherals: Mouse,

keyboard

– Microsoft Windows 7*

(64-bit)

– Microsoft Windows 8.1

(64-bit)

– Microsoft Windows 10

(64-bit)

– Microsoft Windows 11

(64-bit)

– CryptoPro CSP 5.0 R2

MyOffice

Presentation

for Microsoft

Windows

(64-bit)

Microsoft Store

version

– Processor:

1 GHz x86-64

– Memory: 2GB RAM

– Hard disk: 3GB of

available disk space

– Display: 1024х768

screen resolution

– Peripherals: Mouse,

keyboard

– Processor:

2 GHz or faster x86-64

processor

– Memory: 3GB RAM or

more

– Hard disk: 5GB of

available disk space

– Display: 1920х1080

screen resolution and

above

– Peripherals: Mouse,

keyboard

– As required by

Microsoft Store

* For msi builds only

Product (software installer) Software requirements

MyOffice Presentation for macOS*

Mac App Store version

– As required by Mac App Store

*When launching MyOf f ice Standard. Home Edition on Macs with Apple processors f or the f irst time,

installation of  the Rosetta sof tware might be required.
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1.3 Limitations

Supported interface languages:

– English

– French

– Russian

During installation, the application interface language is defined based on the following:

– In Windows OS: By the regional format.

– In macOS: By the preferred language of the OS interface.
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2 INSTALLATION

2.1 Install the software on Windows OS

You can install MyOffice Standard. Home Edition software on Windows in one of the

following ways:

– From the MyOffice website

– From Microsoft Store

2.1.1 Install the software from MyOffice website

To install MyOffice Standard. Home Edition from the MyOffice website, follow these

steps:

1. Go to https://myoffice.ru/products/ofis-dlya-doma. Please note that the software is

downloaded from the website in Russian. The screenshots in the Installation Guide are

taken from the Russian version of the web site. For your convenience, the button names

in Russian are translated into English in parentheses.

2. On the website page, click the Скачать для Windows (Download for Windows)

button (see Figure 1).

Figure 1. Скачать для Windows (Download for Windows) button

https://myoffice.ru/products/standard-home-edition
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3. Fill in the form that opens (see Figure 2): in the first field, fill in your name and in the

second one, your email. Give your consent to the processing of personal data and

consent to the terms of the license agreement by selecting the corresponding

checkboxes at the bottom of the form. After that, click Получить (Get).

Figure 2 . Fill in form to get a software installer

4. In the file manager dialog box, select the path to save the software installer and click

Save.

5. Wait until the software installer is downloaded to your computer and double-click to

run it.

6. If Windows prompts you to confirm the installation, enter the OS administrator

password.
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7. In the welcome window of the Setup Wizard (see Figure 3), click Next.

Figure 3. Setup Wizard welcome window

8. In the Destination Folder window (see Figure 4) specify the folder to install MyOffice

Standard. Home Edition or keep the folder selected by default.

9. To go to the next window, click Next.

Figure 4. Destination Folder window
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10. In the Ready to setup MyOffice Standard. Home Edition window (see Figure 5),

click Install.

Figure 5. Ready to setup MyOffice Standard Home Edition window

11. Wait until all the components of MyOffice Standard. Home Edition are installed

(see Figure 6).

Figure 6. Installation of MyOffice Standard. Home Edition window
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12. In the Completed the MyOffice Standard. Home Edition Setup Wizard window

(see Figure 7), click Finish.

Figure 7. Installation of MyOffice Standard. Home Edition is complete

13. If a message appears on the screen asking you to restart the system, allow this action.

Please note that the software is downloaded from the website in Russian. The screenshots

in the Installation Guide are taken from the Russian version of the web site. For your convenience,

the button names in Russian are translated into English in parentheses.
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2.1.2 Update the application installed from MyOffice website

If you need to update MyOffice Standard. Home Edition installed from MyOffice website,

refer to the window on Figure 9.

If MyOffice Standard. Home Edition is set to auto-update (for more details see Section 2

of the User Guide for MyOffice Text, MyOffice Spreadsheet, or MyOffice Presentation desktop

applications), then when a new version of the product is released, this window opens

automatically while working in MyOffice Text, MyOffice Spreadsheet, or MyOffice Presentation.

If auto-update is not configured, this window can be opened manually. To do this, select

Help > Check for Updates from the Command menu in MyOffice Text or MyOffice Spreadsheet

application (see Figure 8).

Figure 8. Check for Updates menu

To download and install the new version, click Install (see Figure 9).

Figure 9. Window with information on new version
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Wait for the new version of the product to be downloaded to your computer

(see Figure 10).

Figure 10. Application Update window

In the Application Update window (see Figure 11), click Install.

Figure 11. Ready to Install window

The welcome dialog box of MyOffice Standard. Home Edition software setup wizard will

open (see Figure 12).
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Figure 12. Setup wizard welcome window

Close MyOffice Text, MyOffice Spreadsheet, amd MyOffice Presentation and follow steps

5-11 described in Install the software from MyOffice website section.
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2.1.3 Install the software from Microsoft Store

The following is the example of installation of MyOffice Standard. Home Edition on

Windows 10 OS.

To download and install MyOffice Standard. Home Edition from Microsoft Store, do the

following:

1. Open the webpage of MyOffice Standard. Home Edition on MyOffice website:

https://myoffice.ru/products/standard-home-edition. Please note that the software is

downloaded from the website in Russian. The screenshots in the Installation Guide are

taken from the Russian version of the web site. For your convenience, the button names

in Russian are translated into English in parentheses.

2. Click Скачать в Microsoft (Download in Microsoft) (see Figure 13).

Figure 13. Скачать в Microsoft (Download in Microsoft) button

https://myoffice.ru/products/standard-home-edition
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3. On the Microsoft website page, click View in Store (see Figure 14).

Figure 14. Get from Store

4. If https://apps.microsoft.com site does not have permission to always open links in the

Microsoft Store app, in the pop-up message (see Figure 15), click Open Microsoft

Store.

Figure 15. Pop-up message

https://apps.microsoft.com
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5. In Microsoft Store application window, click Install (see Figure 16). To update

MyOffice Standard. Home Edition, in the Microsoft Store application window, click

Update.

Figure 16. Install button
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6. Wait for the download and installation of MyOffice Standard. Home Edition or its

update to complete from Microsoft Store.

Figure 17. Download of MyOffice Standard. Home Edition

Figure 18. Installation of MyOffice Standard. Home Edition
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Figure 19. Download and installation of MyOffice Standard. Home Edition is complete
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2.2 Install and update the software on macOS OS

On macOS, downloading and installing MyOffice Standard. Home Edition is available

from the App Store application.

To install MyOffice Standard. Home Edition, go to the App Store application from

MyOffice website and update the software as described below.

To update MyOffice Standard. Home Edition manually, do one of the following:

– In the App Store's Updates Available pop-up notification, click the Install button.

– Open the App Store app, select the Updates section in the Sidebar and click the Update

button next to MyOffice Standard. Home Edition.

– Go to the App Store app from the MyOffice website and update the software as described

below.

If macOS OS is set to automatically update applications downloaded from the App

Store, MyOffice Standard. Home Edition will be updated automatically when a new

version is released.

To access the App Store application using MyOffice website, follow the steps below:

1. Open the webpage of MyOffice Standard. Home Edition on MyOffice website:

https://myoffice.ru/products/ofis-dlya-doma/. Please note that the software is

downloaded from the website in Russian. The screenshots in the Installation Guide are

taken from the Russian version of the web site. For your convenience, the button names

in Russian are translated into English in parentheses.

https://myoffice.ru/products/standard-home-edition
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2. Click Загрузите в Mac App Store (Download from Mac App Store) (see Figure 20).

Figure 20. Загрузите в Mac App Store (Download from Mac App Store) button

3. If https://apps.apple.com site does not have permission to always open links in App

Store application, in the pop-up message (see Figure 21), click Открыть приложение

“App Store” (Open App Store).

Figure 21. Pop-up message

https://apps.apple.com
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To install or update the software MyOffice Standard. Home Edition, follow the steps

below:

1. To install MyOffice Standard. Home Edition, in App Store application window, click

 (see Figure 22). To update MyOffice Standard. Home Edition, click Update.

Figure 22. Download button



24

© New Cloud Technologies Ltd., 2013–2024 24

2. Wait until MyOffice Standard. Home Edition download from App Store and installation

is complete (see Figure 23).

Figure 23. Download and installation process
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To open MyOffice Standard. Home Edition, do one of the following:

– In App Store application, click Open (see Figure 24).

Figure 24. Open button

– Open the Launchpad and click the MyOffice Standard. Home Edition icon

(see Figure 28).
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3 VERIFY SUCCESSFUL INSTALLATION

3.1 Verify successful installation on Windows OS

If you installed MyOffice Standard. Home Edition from MyOffice website, and you see the

shortcuts shown on Figure 25, and in the main menu of the OS (see Figure 26) and, when clicked,

the corresponding applications open correctly without issuing failure messages, that means you

have successfully installed MyOffice software.

Figure 25. MyOffice Standard. Home Edition Windows OS desktop shortcuts

Figure 26. MyOfficeMyOffice Standard. Home Edition shortcuts in the Windows OS main menu
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If you installed MyOffice Standard. Home Edition from Microsoft Store, and the

application shortcuts are displayed in the Start menu of the OS (see Figure 27), which, when

clicked, open the corresponding applications without issuing failure messages, that means you

have successfully installed MyOffice software.

Figure 27. MyOffice Standard. Home Edition shortcuts in the Windows OS main menu
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3.2 Verify successful installation on macOS

If you installed MyOffice Standard. Home Edition from Mac App Store, and the icons

shown on Figure 28 are displayed in Launchpad and, when clicked, the home page opens correctly

without issuing failure messages, that means you have successfully installed MyOffice Standard.

Home Edition.

Figure 28. Icons of MyOffice Standard. Home Edition in Launchpad
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4 CONFIGURE MYOFFICE APPLICATIONS

You can open the files you are working on in other text or spreadsheet editors directly from

MyOffice Spreadsheet or MyOffice Text. To select the application that you want to use, click

File > Open With command (see Figure 29) in the Command menu.

You can configure the Command menu item File > Open With command only for

MyOffice Text and MyOffice Spreadsheet editors in Microsoft Windows.

The list of programs available for selection is customizable using the OpenWithList.ini

file. If this file does not contain data or contains incorrect data, the File > Open With command it

is not displayed in the Command menu.

Figure 29. Open With menu

To add, change or delete a program from the list, follow these steps:

1. Run a text editor installed in the OS as an administrator (for example, Notepad in

Windows OS).

2. In a text editor, open the file <installation folder> > Resources > OpenWithList.ini

file, where <installation folder> is the installation folder for MyOffice Standard. Home

Edition.

3. Change the file as needed. Keep the following data structure in the file

(see the example below): 
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– [section name] is an application in MyOffice Standard. Home Edition for which the

list is created:

· [MyOffice Text Home Edition] is MyOffice Text application.

· [MyOffice Spreadsheet Home Edition] is MyOffice Spreadsheet application.

– [ordinal number\AppPath] where:

· sequence number is the application sequence number in the list.

· appPath is the full path to the executable file of the program. The path should

appear in quotation marks. In Windows, directory names should be separated using

a slash (/) or a double backslash (\\) when specifying the path to a file.

– [serial number\appTitle] where:

· sequence number is the application sequence number in the list.

· appTitle is the short name under which the program will be displayed in the list.

The name should appear in quotation marks. If the name of the application is not

specified in the configuration file, the list will display the title of its executable file

without extension.

4. Save the file in UTF-8 format.

5. Restart the application to see the changes made.

Example of OpenWithList.ini file:

[MyOffice Text Home Edition]
1\appPath="C:/Program Files/LibreOffice/program/swriter.exe"
1\appTitle="LibreOffice Writer"
2\appPath="C:\\Program Files\\Microsoft Office 15\\root\\Office15\\WINWORD.EXE"
2\appTitle="Word"

[MyOffice Spreadsheet Home Edition]
1\appPath="C:/Program Files/LibreOffice/program/scalc.exe"
1\appTitle="LibreOffice Calc"
2\appPath="C:\\Program Files\\Microsoft Office 15\\root\\Office15\\EXCEL.EXE"
2\appTitle="Excel"
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5 UNINSTALL

5.1 Uninstall on Windows OS

5.1.1 Uninstall the software installed from MyOffice website

If you installed MyOffice Standard. Home Edition from the MyOffice website, you can

uninstall it using the main menu or the Windows Control Panel. The following is the example of

how the applications can be deleted in Windows 10 OS.

To delete MyOffice Standard. Home Edition from the Windows Start menu, follow these

steps:

1. Open the Start menu in Windows OS.

2. Scroll down the list of installed applications until you reach the letter М.

3. Expand the MyOffice Standard. Home Edition folder (see Figure 30).

Figure 30. MyOffice Standard. Home Edition folder



32

© New Cloud Technologies Ltd., 2013–2024 32

4. Select Uninstall MyOffice Standard. Home Edition (see Figure 31).

Figure 31. Run the Windows Installer

5. In the Windows Installer dialog box, click Yes (see Figure 32).

Figure 32. Windows Installer
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6. Wait until all the components of MyOffice Standard. Home Edition are deleted (see

Figure 33).

Figure 33. Delete all components

To delete MyOffice Standard. Home Edition from the Windows Control Panel, follow

these steps:

1. Open the Control Panel.

2. In the Control Panel window, select Programs and Features.

3. In the list of programs and features, select MyOffice Standard. Home Edition and

click Uninstall (see Figure 34).

Figure 34. Uninstall or change a program window

4. In the Programs and Features dialog box, click Yes (see Figure 35).
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Figure 35. Programs and Features window

5. Wait until all the components of MyOffice Standard. Home Edition are deleted (see

Figure 33).
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5.1.2 Uninstall the software installed from Microsoft Store

If you installed MyOffice Standard. Home Edition from Microsoft Store, you can delete it

using the Start menu of Windows OS. The following is the example of how the applications can be

deleted in Windows 10 OS.

To delete the applications, do the following:

1. Open the Start menu in Windows OS.

2. Scroll down the list of installed applications until you reach the letter М.

3. Right-click on the line where you will see MyOffice Text. Home Edition, MyOffice

Spreadsheet. Home Edition or MyOffice Presentation. Home Edition to open the

context menu and click Uninstall (see Figure 36).

Figure 36. Delete MyOffice Standard. Home Edition from the main menu
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4. In the window with the message “This application and its related info will be

uninstalled”, click Uninstall (see Figure 37). All MyOffice Standard. Home Edition

components will be uninstalled.

Figure 37. Selected action confirmation window
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5.2 Uninstall the software installed on macOS OS

If you want to uninstall MyOffice Standard. Home Edition, you can use the Finder. To do

this, proceed as follows:

1. Open the Finder (see Figure 38).

2. On the Sidebar, select Applications folder.

3. In the Applications folder, select MyOffice Standard. Home Edition.

4. Delete the application(s) in one of the following ways:

– At the top of the Finder window, click � Action button and in the drop-down list,

select Move to Bin command.

Figure 38. Action button

– Right-click to open the context menu and run the Move to Bin command (see

Figure 39).

Figure 39. Context menu

– Hold down the left mouse button and drag MyOffice Standard. Home Edition to the

Bin folder in Dock.
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